
AL/OE-TR-1996-0062 A Partnership to Improve the 
Environment 

A 
R 
M 
S 
T 
R 
O 
N 
G 

L 
A 
B 
O 
R 
A 
T 
O 
R 
Y 

SINGLE EVENT NOISE MODEL (SENM) 
DESCRIPTION AND USER'S GUIDE 

Mark R. Cosby 
Science Applications International Corporation 

1710 Goodridge Drive 

P.O. Box 1303 

McLean VA 22102 

OCCUPATIONAL AND ENVIORNMENTAL HEALTH DIRECTORATE 

Bioenvironmental Engineering Division 

Noise Effects Branch 

2610 7th Street 

Wright-Patterson Air Force Base, OH 45433-7901 

■"»«tuora», 
May 1996 

Final Technical Report for the Period of August 1993 to July 1995 

i 

Approved for public release; distribution is unlimited. 

19960531 050 
AIR FORCE MATERIEL COMMAND 
BROOKS AIR FORCE BASE, TEXAS 



DISCLAIM» NOTICE 

THIS DOCUMENT IS BEST 

QUALITY AVAILABLE. THE COPY 

FURNISHED TO DTIC CONTAINED 

A SIGNIFICANT NUMBER OF 

PAGES WHICH DO NOT 

REPRODUCE   LEGIBLY. 



NOTICES 

When US Government drawings, specifications, or other data are used for any purpose other 
than a definitely related Government procurement operation, the Government thereby incurs no 
responsibility nor any obligation whatsoever, and the fact that the Government may have 
formulated, furnished, or in any way supplied the said drawings, specifications, or other data, is 
not to be regarded by implication or otherwise, as in any manner licensing the holder or any 
other person or corporation, or conveying any rights or permission to manufacture, use, or sell 
any patented invention that may in any way be related thereto. 

Please do not request copies of this report from the Armstrong Laboratory. Additional copies 
may be purchased from: 

National Technical Information Service 
5285 Port Royal Road 
Springfield, Virginia 22161 

Federal Government agencies registered with the Defense Technical Information Center should 
direct requests for copies of this report to: 

Defense Technical Information Center 
Cameron Station 
Alexandria, Virginia 22314 

DISCLAIMER 
This Technical Report is published as received and has not been edited by the Technical Editing 
Staff of the Armstrong Labortory. 

TECHNICAL REVIEW AND APPROVAL 

AL/OE-TR-1994 

This report has been reviewed by the Office of Public Affairs (PA) and is releasable to the 
National Technical Information Service (NTIS). At NTIS, it will be available to the general 
public, including foreign nations. 

This technical report has been reviewed and is approved for publication. 

ROBERT A. LEE 
Chief, Noise Effects Branch 

iCTOR 

BOLM 
ACTING CHIEF,   BIOENVIRONMENtfAL JENGINEERING DIVISION 

Armstrong Laboratory 



REPORT DOCUMENTATION PAGE Form Approved 
OMB No. 0704-0188 

Public reporting burden for this collection of information is estimated to average 1 hour per response, including the time for reviewing instructions, searching existing data sources, gathering 
and maintaining the data needed, and completing and reviewing the collection of information. Send comments regarding this burden estimate or any other aspect of this collection of 
information, including suggestions for reducing this burden, to Washington Headquarters Services, Directorate for Information Operations and Reports, 1215 Jefferson Davis Highway, Suite 
1204, Arlington, VA 22202-4302, and to the Office of Management and Budget, Paperwork Reduction Project (0704-0188), Washington, DC 20503. 

1. AGENCY USE ONLY (Leave blank) 2. REPORT DATE 
May  1996 

3. REPORT TYPE AND DATES COVERED 

Final Report for the Period of August 1993 thru July 1995 
4. TITLE AND SUBTITLE 

Single Event Noise Model (SENM) Description and User's Guide 

6. AUTHOR(S) 

Science Applications International Corporation 

5. FUNDING NUMBERS 

PE 637160 
PR 4223 
TA 42230B 
WU4223OB02 
F33614-89-C-0574 

7. PERFORMING ORGANIZATION NAME(S) AND ADDRESS(ES) 

SAIC 
1710 Goodridge Drive 
P.O. Box 1303 
McLean Virginia 22102 

8. PERFORMING ORGANIZATION 
REPORT NUMBER 

9. SPONSORING/MONITORING AGENCY NAME(S) AND ADDRESS(ES) 
Armstrong Laboratory 
Occuptational and Environmental Health Directorate 
Bioenvironmental Engineering Division, Noise Effects Branch 
2610 7th Street 
Wright-Patterson Air Force Base, Ohio 45433-7901  

10. SPONSORING/MONITORING 
AGENCY REPORT NUMBER 

AL/OE-TR-1996-0062 

11. SUPPLEMENTARY NOTES 

12a. DISTRIBUTION/AVAILABILITY STATEMENT 

Approved for public release; distribution is unlimited. 

12b. DISTRIBUTION CODE 

13. ABSTRACT (Maximum 200 words) 

Public groups and some federal agencies are pressuring DoD to include single event noise and impulsive noise impact 
analyses in Environmental Impact Assessment Process (EIAP) documents. The Strategic Environmental Research and 
Development Program (SERDP) office funded an effort to improve and evaluate a single event noise model (SENM) for 
aircraft noise. The validation of the SENM included noise from subsonic and supersonic aircraft activity. This model 
provided a defensible analytical approach to assess single event noise impacts generated by DoD operations and will aid in 
complying with the National Environmental Policy Act (NEPA). The basis of the SENM is a noise program previously 
developed with Advanced Research Project Agency funding. The program was orginally developed for underwater acoustics 
and was recently converted to atmospheric acoustics. Development of this program directly supports the tri-service strategic 
plan for the compliance pillar of research and development objective of developing improved assessment tools related to 
environmental management. It assists DoD in producing defensible EIAP documents concerning noise generated in 
sensitive areas such as parks and wilderness areas. This report is a user's manual describing the SENM that was developed 
under this SERDP project 

14. SUBJECT TERMS 
Aircraft Noise       Environment       Noise       Noise Prediction 
Predictions Impulse Noise Propagation 

15. NUMBER OF PAGES 

16. PRICE CODE 

17. SECURITY CLASSIFICATION 
OF REPORT 

UNCLASSIFIED 

18. SECURITY CLASSIFICATION 
OF THIS PAGE 

UNCLASSIFIED 

19. SECURITY CLASSIFICATION 
OF ABSTRACT 

UNCLASSIFIED 

20. LIMITATION OF 
ABSTRACT 

UNLIMITED 

NSN 7540-01-280-5500 Standard Form 298 (Rev 2-89) Prescribed by ANSI Std Z-39-18 
298-102   COMPUTER GENERATED 



THIS   PAGE   INTENTIONALLY   LEFT   BLANK 

XI 



Table of Contents 

Ease. 
1.0      OVERVIEW 1 

2.0      DESCRIPTION OF THE COMPUTATIONAL MODEL 1 
2.1 General 1 
2.2 Propagation   Algorithms 3 
2.3 Sound Calculations 6 
2.4 Parameterization of Inputs and Outputs 10 

3.0      EXECUTION OF THE COMPUTATIONAL MODEL 13 

4.0      DESCRIPTION OF THE GRAPHICAL MODEL AND 
EXECUTION INSTRUCTIONS 19 

XXX 



List of Figures 

Page 
Figure 2.1-1    Original SPL Scaled to 12,700 lbs/hr 2 

Figure 2.3-1    SENM A-weighted sound level calculation „8-9 
Figure 3.0-1   Parameter   input   file 14 
Figure 3.0-2   Source routes file         15 

Figure 3.0-3   Source SPL input file 16 

Figure 3.0-4   Output   log   file  17 

Figure 3.0-5   Sample Analysis        18 

Figure 3.0-6   Output plpos file  18 

Figure 4.0-1   Main   Window  19 

Figure 4.0-2   Window Attributes    21 

Figure 4.0-3   Tear-off Menu with Window Menu on  22 
Figure 4.0-4   File menu  22 
Figure 4.0-5   Information Dialog Box  23 
Figure 4.0-6   File Subsystem Dialog Box         23 
Figure 4.0-7   Error Dialog Box  24 
Figure4.0-8   Reading the SPL Map File  25 
Figure 4.0-9    Converting SPLs to Color Values        26 
Figure 4.0-10 First SPL Map Image  26 
Figure 4.0-11 View Menu  27 

Figure 4.0-12 Information Dialog Box  28 

Figure 4.0-13 Last  SPL  Map  Image  28 
Figure 4.0-14 Options Menu „  2Q 
Figure 4.0-15 Sound Floor Range  30 

Figure 4.0-16 SPL Map Image with Set Sound Floor  30 
Figure 4.0-17 SpeedDialog „    31 

Figure 4.0-18 Toggles   Dialog      32 

Figure 4.0-19 SPL Map Image with Terrain Contour Overlay 33 
Figure 4.0-20 SPL Map Image in Proportional Mode       33 

Figure 4.0-21 AL Map Image with Microphones and Terrain 35 
Contour Overlays 

IV 



1.0 

DESCRIPTION AND USER'S GUIDE FOR 
THE SINGLE EVENT NOISE MODEL (SENM) 

OVERVIEW 

The Single Event Noise Model (SENM) is an interactive, dynamic aircraft noise assessment 
tool being developed for the U.S. Air Force Armstrong Laboratory at Wright Patterson Air Force 
Base. SENM's purpose is to provide a credible representation of the physics of atmospheric 
sound propagation, of sound interaction with terrain and structures, and high resolution 3-D 
graphical depiction's of noise fields with simultaneous display of the terrain. SENM is comprised 

of two separate models functionally integrated via their databases. The first will be referred to as 
the computational model and the second as the graphical model. The computational model can be 
used as a stand alone analysis tool or used to generate input data for the graphical model. The 
graphical model is used to animate and visualize the A-weighted sound level (AL) data generated 
by the computational model for analysis and demonstration of noise field characteristics and 
influences. 

Both the computational and graphical models are written in ANSI C with all function calls 
prototyped. As such, both applications are portable to all major UMX workstation vendors 
including DEC, HP, IBM, SGI, and SUN. Current implementations include SUN Sparc and SGI 
Indigo platforms. The graphic data visualization tool uses the Motif 1.2.3 tool kit and XI1R5 for 
display. 

2.0 DESCRIPTION OF THE COMPUTATIONAL MODEL 

2.1 General 

The SENM model referred to in this section will be the computational model unless 
otherwise noted. SENM predicts noise levels from aircraft and the measurements that would be 
obtained if noise levels were monitored in real-time by microphones on the ground. SENM makes 
adjustments to the input sound pressure level (SPL) for each aircraft contributing to sound levels at 
the simulated point of measurement, based on physical phenomena that alter the propagation of 
aircraft noise. SENM accounts for the temperature, relative humidity, wind direction, and wind 
speed within its propagation algorithms. The propagation phenomena modeled are spherical 
spreading, terrain masking, shadow zones, ground impedance, and atmospheric absorption. 



The aircraft source is specified quantitatively as sound pressure level spectra, normalized to 
some reference distance, as a function of frequency and aspect angle with respect to the flight path 
for a given power setting. Typical source input data has been obtained from military ground runup 
data. SENM linearly interpolates the source SPL between measurement point aspect angles to 
provide angular continuity in acoustic signature representation. Figure 2.1-1 depicts a 
representative aircraft acoustic signature characterization used in SENM. The source positions 
over time are input separately as described in section 2.4. Cylindrical symmetry of the source 
acoustic signature is assumed. Each aircraft may have multiple power settings. The power setting 
is included with each input position point and can change with each position point. SENM handles 
multiple aircraft simultaneously. 

270 90 

180 

Figure 2.1-1 Original SPL Scaled to 12,700 Ibs/hr 

SENM calculates the A-weighted sound level at each time step for every grid point 
requested. Data is calculated for 24 one-third octave band centers (50 Hz - 10,000 Hz). The user 
decides whether to generate data for an entire grid area or for individual grid points. The grid area 
is defined by the user and divided into individual grid points. The AL is calculated and stored for 
each grid point for each time step. This entire set of AL values for each grid point and time step is 
referred to as the SPL map and is stored as a binary file. The SPL map is displayed graphically in 



the graphical model described in section 4.0. The sound exposure level (SEL) is also calculated at 
the end of a simulation run for each grid point and stored as a binary map. 

2.2     Propagation Algorithms 

The loss of signal power as the signal propagates from the source to the sensor must be 
accounted for. Detailed physical models and in-depth understanding of tpropagation loss effects 
involve basic research questions in aircraft acoustics. The SENM implementation successfully 
compromises between computational efficiency while adequately accounting for the important 
phenomenological variability in the effects. SENM is effective in capturing first-order performance 
characteristics of acoustic environments. The refinement and calibration of the propagation 
representation in SENM is a continuing emphasis area for further enhancement 

Propagation phenomena that affect signal strength include spherical spreading, atmospheric 
absorption, ground impedance effects, shadow zone effects, and terrain masking. Only spherical 
spreading and atmospheric absorption are well enough understood to model with high confidence. 
Spherical spreading is frequency-independent and produces 1/R2 acoustic power loss with range 
R. Atmospheric absorption is frequency-dependent and SENM uses the SAE Standard to 
represent this effect The loss due to absorption is calculated using the band center frequency for 
each of the 24 one-third octave bands. 

A model for ground impedance effects near to the sensor is also included. The basic model 
accounts for the impedance difference between the air and the local ground. The gain in signal 
power due to the presence of an interface is 

.2xäS 

l+p(f)eJ c 

where c is the speed of sound (as a function of temperature), p is a frequency-dependent complex 
reflection coefficient and A is the path length difference between a direct ray from the source to the 
receiver and a ground-reflected ray. 

The reflection coefficient is 

sinö.-Zi/Zj p —  
sinft + Zi/Z* 



where ö,is the elevation angle from the sensor to the emitter, 

v-0.75 

^ = 1 + 9.081 
\OP~J 

and 

X2=l\.9\-f—\ 
\Oflow) 

where aflow is flow resistivity. Flow resistivity values can range from several tens to a few 

thousand, depending upon the surface. Very high numbers correspond to hard reflective surfaces 
like macadam. The flow resistivity is a user defined parameter in SENM. The impact of the 
surface can be studied parametrically by analyzing the effect on the results of changing this 
parameter. 

The path length difference is 

where d is the separation of the source and receiver along the ground, hs is the source height, and 
hr is the receiver height above the ground. 

The ground impedance model used alone tends to overestimate signal loss for very low 
elevation angles. The ground effect loss is probably not actually overestimated, but other effects 
such as acoustic scattering in a turbulent atmosphere may cause the sound to be more intense than 
that predicted by a model that considers the ground impedance effect only. Because of this, the 
ground impedance model includes logic to limit losses due to the ground effect at very low source- 
to-receiver elevation angles. The loss term is clamped at the value for <j>g if the actual elevation 
angle is less than <|)g°. <|>g is a user defined parametric threshold in SENM. As with other 

frequency-dependent factors, the performance model calculates the loss (or gain) due to ground 
effect using the band center frequency for each of the 24 one-third octave bands. 



Other propagation effects are even more complex to represent in the model. The first of 
these complex phenomena is the signal loss due to terrain masking. For that, we include a single 
parameter LTM- When (acoustic) line of sight is lost, the signal will loose LTM dB relative to what 
it would have been if there were no loss of line of sight. A typical value for LTM from field test 
data is 10 dB. LTM is a user defined parameter in SENM. Better models for signal levels when 
line of sight is lost can be inserted into SENM when accredited to be better then the field data 
extrapolations. 

Another important complex phenomenon to model is shadow zones and propagation into 
shadow zones. Shadow zone formation and characterization depend largely upon temperature and 
wind profiles. The temperature profile effects are isotropic; that is, the shadow or ducting effect 
does not depend upon the orientation of the source and receiver, only upon the temperature profile 
and relative heights of the source and receiver. However, wind effects are not isotropic. They 
depend on the direction of propagation relative to the wind as well as the vertical temperature 
profile of the wind. The overall effect is that when the wind blows from the source toward the 
receiver the sound is louder than when the wind blows in the other direction. Crosswinds present 
minimal effects. Ray theory predicts no propagation into a shadow zone. In fact, there is 
significant signal in the shadow zone. SENM calculations account for these factors with five 
parameters. These are Lsz, dw/dz, 8W, wo, and dcx/dz. Signal strength in a shadow zone is 

decreased by the user defined value of La dB from what it would have been without the shadow 
zone. 

The other four parameters are used to determine, for the given source-receiver 
configuration, if there is a shadow zone. Parameters are: the derivative of wind speed with respect 
to altitude, dw/dz; the wind direction, 9W; the wind speed close (at 1 meter elevation) to the 

ground, wo; and the gradient of sound speed with respect to altitude, dcT/dz, which is actually 
caused by the gradient of temperature as a function of altitude. The model is applied with the 
assumption of a constant gradient of wind and sound speed with altitude for the emitter. The 
equation for the distance from the source to the shadow zone is 

& = 
2(co+WoCOs(6-8wj)      i r—       r— x 
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where 0 is the direction of sound propagation, the direction from the source to the sensor. This is 

a standard result. ("The shadow zone in a stratified medium," R. Makarewicz, JAS A V85, N3, 
March 1989, ppl092-1096). 

The adiabatic temperature lapse rate is -9.8 degrees per kilometer. The speed of sound (in 
meters per second) varies as the square root of the temperature in Kelvin but can be approximated 
as changing by 0.61 times the Centigrade temperature in the temperature region of interest. Thus, 
for normal lapse conditions, the nominal value to use for dcr/dz is 0.61*(-9.8)=6.0 meters/sec/km 
or -0.006 m/s/m. 

Selection of a wind speed and gradient is more difficult, especially since a logarithmic, not 
linear, change in wind speed with altitude may be more physically accurate. Our primary rationale 
for using the linear model as the default representation in SENM is the need to approximate the 
wind over only a small range of altitudes and the linear model supports a closed form expression 
for the distance to the shadow zone. The wind gradient should be selected to represent the average 
conditions between the sensor and the aircraft heights. Aircraft altitude can have a significant 
effect. The gradient up to 50 meters in altitude is about 0.06 m/s/m. Up to 100m it is 
approximately half that value. This is for a fairly substantial ground-level wind of about 10m/s 
(about 20 knots). At least for winds this high, clearly the wind effect is more important than the 
temperature effect and the nonlinear (perhaps logarithmic) variation of wind speed with altitude is 
justified. For initial studies we suggest using the above values for 50- and 100-meter emitters in a 

20-knot wind, scaling the values with wind speed for other speeds, and reducing the average wind 
gradient by 1/2 for every doubling of aircraft altitude. 

Except for the spherical spreading and atmospheric absorption models, all the propagation 
model elements described above are intended to be useful working hypotheses for the purpose of 
noise impact studies and SENM accreditation for specific uses. 

2.3     Sound Calculations 

SENM calculates the A-weighted sound level for each grid point and time step as well as 
the sound exposure level for each grid point at the end of the simulation. Both sets of values are 
output as binary files that can be visualized using the graphical model. Figure 2.3-1 shows the 
logical flow of the AL calculations within SENM. 



All the propagation effects discussed in the previous section create either a dB loss or gain 
at the point of measurement. These are combined with the input source position, orientation and 
SPL (dB) at the appropriate frequency and aspect angle yielding the SPL occurring at a specific 
time and grid point. In order to obtain the SPL with exponentially weighted time averaging, the 
value is approximated by using four instantaneous samples and smoothing them with weighting 
factors. These weighting factors were derived by Dr. W. J. Galloway and can be seen in the 
following equation. 

SSPLk,n,j = 0.39 * SPLk,n.j + 0.27 * SSPLk-l,n,j + 0.21 * SSPLk-2,n,j 
+ 0.13 * SSPLk-3,n,j 

where k is the current time step, n is the grid point, and j is the frequency band index. SSPL 
represents the smoothed SPL. Smoothing is done once k is greater than 3. The smoothed SPL 
values are then combined with the appropriate A-weighting relative frequency response (dB) 
resulting in an A-weighted SPL for each frequency, grid point, and time step. 

AWSSPLk,n j = SSPLk,n,j + AWj 

where AWj is the relative frequency response for A-weighting for frequency band j. These A- 

weighted SPL values for each frequency are then combined to yield the A-weighted sound level for 
each grid point and time step. 

ALk,n = 10 * LOG (10 dj AWSSPL^/IO), j=i7,40. 

The SEL is the combination of the AL values from all time steps for each grid point; 

SELn = 10 * LOG (At) + 10 * LOG (10 (£k AL^/IO), 

k=first time step, last time step 

where At is the time step size (currently 0.5 seconds). It is understood that for high velocity 
(>350kts) emitters the 0.5 second time step does not offer the spatial or temporal resolution 
necessary to resolve the emitter as a point (vice a line) source. This source of distortion in model 
output is believed to be rninimal at this time, but should be investigated against flight profile data 
for maneuvering and accelerating emmitters. 
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2.4     Parameterization of Inputs and Outputs 

SENM is driven by one main input parameter file. It is entered as a command line input to 
the model (the first of two command line inputs). A detailed description of executing the model can 
be found in section 3.0. The parameter file includes the names of other files required as input for a 
particular run of SENM. The number of input files varies but will always include the parameter 
file, an aircraft route file, and at least one source SPL file. Other optional input files are a terrain 

map and additional source SPL files for multiple power settings. There are four output files 
generated. The user defines a prefix file name for each of the output files in the parameter file. 
The output files are Prefixing, Prefix.map, Prefix.plpos, and Prefix.avg. 

Input Files: 
Parameter File 

Simulation start time, simulation end time, simulation time step (currently must be 0.5 
seconds) 

Grid map specifications: Resolution of each grid point, X & Y dimensions, Map center 
(both in X, Y and LatXon) 

or XYZ location for specific grid points 

Terrain map specifications: Number of X & Y points, Resolution of each grid point 
• Output file prefix 
• Input file names 

Observation height (microphone height above the ground) 
• Air temperature and relative humidity 

Terrain masking Power Loss (if the sound path between the source and the receiver is 
masked by the terrain this value is used as a dB loss in signal strength) 

Shadow Zone Signal Strength Loss (if the sound path between the source and the receiver 
propagates into a shadow zone this value is used as a dB loss in signal strength) 
Wind direction and speed 

How resistivity constant (this value is used to describe the surface over which the aircraft is 
flying; grass, dirt, etc.) 

Sine of the minimum elevation angle used for the ground impedance algorithm (typically 
the minimum elevation angle is 2.5 degrees) 

Delta time for tolerance checks (this value is used when calculating the time at which the 
sound that is heard is actually emitted) 

Reference distance from source (this value corresponds to the source runup SPL input data) 

10 



Terrain Map File 

This file contains the altitude at equally spaced points across a defined area. The inputs for 
the defined terrain map grid area are entered in the parameter file. This file contains n x m values 
(altitudes). 

Aircraft Route File 

• AircraftlD 

• Time, X, Y, Z, and power setting (There is a separate line of this format for each aircraft 
position recorded. A cubic spline algorithm is used to interpolate between two input 
positions.) 

Source SPL File 

This file contains sound pressure levels from runup data for a given power setting. The 
power settings recognized by SENM are: AfterBurner, Takeoff, Approach, Intermediate, and 
Maximum. Different SPL files can be used at different points of each aircraft's flight. The power 
settings are specified in the aircraft route file at each defined point along the flight of the aircraft. 
Each source SPL file contains 24 lines of 19 SPL values per line. Each line represents one of the 
24 one-third octave bands. Each column represents aspect angles of 0,10,20,... 180 Degrees. 

Output Files: 
Prefix.log 

This file contains a log of many simulation events including most error messages produced 
by SENM. The amount of data output to this file is controlled by the second (and last) command 
line input, either "true" or "false". A "false" command line input will output only the major 
simulation events such as aircraft positions, aircraft additions and removals from the simulation, 
aircraft power setting changes, and error messages. 

A "true" command line input will output a lot of data for each grid point, simulation time 
step, and frequency. This data is useful when analyzing single grid points as is the case when 
comparing against real world microphone data. A sample log file and description can be found in 
section 3.0. 

11 



Prefix.map 

This is a binary file containing the A-weighted sound level for each grid point requested by 
the user for every simulation time step. This file is displayed for visualization by the graphical 
model described in section 4.0. The data are stored as binary unsigned characters since the values 
fall between 0 and 255. 

Prefix.plpos 

This file contains each aircraft's XYZ position for each simulation time step. 

Prefix.avg 

This is a binary file containing the sound exposure level for each grid point requested by 
the user. The data are stored as binary unsigned characters since the values fall between 0 and 
255. 

12 



3.0     EXECUTION OF THE COMPUTATIONAL MODEL 

SENM input is controlled from the input parameter file. This file is entered as the first of 
two command lines inputs when executing the model. The second command line input is either 
"true" or "false" and controls the amount of data output to the Prefix.log file. There are two 
different modes of operation using SENM. Mode I generates data for an entire grid area defined 
by the user in the parameter file. When operating in this mode, a command line input of "false" 

should be used. A "true" command line input could potentially lead to hundreds of megabytes of 
unused data. Mode II generates data for one grid point (or a small number of grid points). This 
mode is useful when analyzing the output at a specific microphone location, band by band. A 
"true" command line input is used to output the detailed band by band data. Both modes are 
described in this section. 

SENM is executed by the following command line: 

%SENM    parameter_file_name    true 

A sample parameter input file can be found in Figure 3.0-1. The user can edit the 
parameter file using any editor available. It is stored as an ASCII file. Any parameter can be 
altered by the user. Most inappropriate values trigger an error message in the log file and execution 
is halted. If the simulation start and end time exceeds the aircraft's flight, simulation is limited to 
the beginning and ending time of the aircraft(s). If the aircraft's flight exceeds the simulation time 
interval, the simulation time interval is adhered to. This allows for analyzing specific time 
intervals. The input time step must currently be set to 0.5 seconds to allow for proper smoothing 
equations approximating the exponential time averaging of the AL. 

If running in mode I, the "Number of Specific XYZ Points" should be set to 0 and no 
values should be entered. If running in mode II, the desired number of points should be entered as 
the "Number of Specific XYZ Points" and an XYZ value for each point should follow, one point 
per line. The XYZ values are in meters and should be referenced to the same origin as the values 
in the aircraft routes file. 

The names of the other input files required for each run and the prefix of each of the output 
files are entered in the parameter file. The file names should include appropriate directory names as 
well. The prefix name should also include the proper directory where the file is to be stored. This 
is especially important when operating in mode I and generating SPL maps for use with the 
graphical model. 

13 



Sample parameters input file: 
Processing Time Interval 

StartTime: 5520 seconds 
EndTime: 51840 seconds 
Updatelnterval:        .5 seconds 

Power Map Parameters 
MapScale (Resolution): 
MapRangeX (X Axis): 
MapRangeY (Y Axis): 
MapCenter: 
Latjxm of MapCenter 
Number of Specific XYZ Points: 1 

0.0    0.0    0.0 

50 meters 
20000 meters 
5000 meters 
0.0 0.0 meters 
40.0 -110.0 Degrees 

Terrain Map Parameters 
Number of X Points: 0 meters 
Number of Y Points: 0 meters 
MapDeltaX: 90 meters 
MapDeltaY: 90 meters 

Output/Input Files 
Output Prefix (*.log,*.map,*.plpos,*.avg): 
Terrain Map Input File Name: 
Airplane Route Input File Name: 
AfterBurner SPL Input File Name: 
Takeoff SPL Input File Name: 
Approach SPL Input File Name: 
Intermediate SPL Input File Name: 
Maximum SPL Input File Name: 

Miscellaneous Parameters 
Observation Height: 
Air Temperature: 
Relative Humidity of Air: 
Terrain Masking Power Loss: 
Shadow Zone Signal Strength Loss: 
Wind Direction: 
Wind Speed: 
Flow Resistivity (Sigma Flow): 
Sin of MinElv for Ground Impedance: 

*/ 
Delta Time for tolerance checks: 
Reference distance from source: 

/home/SENM/output/PREFTX_GOES_HERE 
None 
/home/SENM/SOURCE_INPUT/Aircraft_track_mod5jts 
None 
/home/SENM/SOURCE_INPUT/norm_SPL.out 
None 
None 
None 

1.2192 meters 
50.0 Degrees Fahrenheit 
49.0 Percent 
-10.0 dB 
-10.0 dB 
3.49 rad 
4.63 meters/sec 
200.0 
0.0436 /* Min. elev. angle 2.5 deg. 

0.1 sec 
76.2 meters/* 250 ft*/ 

Figure 3.0-1 Parameter input file 

The graphical model uses the same parameter input file and finds its input SPL maps using the 
output prefix found in the parameter file. 
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The aircraft routes file may contain multiple aircraft. The data for the second aircraft is 
appended after the data for the first, and so on. A sample routes file can be found in Figure 3.0-2. 
The power setting in the sample file is "Takeoff. Use of this file requires an input file to be 
entered in the parameter file as "Takeoff SPL Input File Name." Different power settings can be 
set for any time step entered in the routes file. Each power setting requires a corresponding source 
SPL file. A sample source SPL file can be found in Figure 3.0-3. The time in the routes file is 
seconds, the XYZ points are in meters. The routes file can be of any length to accommodate the 
flight of the aircraft 

Aircraft ID 
50696.00 -11627.88 404.68 399.12 Takeoff 
50696.25 -11607.83 394.63 397.52 Takeoff 
50696.50 -11587.77 384.62 396.01 Takeoff 
50696.75 -11567.71 374.65 394.60 Takeoff 
50697.00 -11547.65 364.71 393.28 Takeoff 
50697.25 -11527.60 354.82 392.05 Takeoff 
50697.50 -11507.54 344.97 390.91 Takeoff 
50697.75 -11487.49 335.15 389.87 Takeoff 

50846.75 5280.04 -266.60 315.47 Takeoff 
50847.00 5346.79 -265.73 318.56 Takeoff 
50847.25 5413.67 -264.78 322.39 Takeoff 
50847.50 5480.67 -263.77 326.99 Takeoff 
50847.75 5547.80 -262.67 332.38 Takeoff 
50848.00 5615.06 -261.51 338.56 Takeoff 

Figure 3.0-2 Source routes file 
The values in the source SPL files are sound pressure levels in dB. Each line represents 

the value for each of the band center frequencies for each of the 24 one-third octave bands. Each 
column represents aspect angles with respect to the flight path of 0 to 180 degrees (every 10 
degrees). 

During execution of SENM, the simulation clock time is output to the screen. This allows 
the user to follow the progress of a run. A typical run operating in mode I for one aircraft, 300 
time steps, and 40,000 grid points on a SPARC 10 model 41 (40 MHz Super Sparc processor) is 
13 hours. The same run on a Silicon Graphics Indigo Elan (50/100 MHz R4000 processor) is 10 
hours. Run times for analyzing specific single grid points are a few seconds. Detailed analysis of 
single points should be run in mode II due to the prohibitive size of the output log file and run time 
when operating in mode I. 
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84 85 
86 87 
88 89 
90 91 
93 94 
96 96 
95 96 
93 97 
96 101 
104 105 
102 108 
101 106 
98 104 
96 101 
95 99 
93 96 
90 94 
88 92 
87 91 
84 88 
82 86 
79 83 
75 79 
72 75 

87 
89 
91 
93 
94 
96 
96 
98 
100 100 

87 
89 
91 
93 
94 
96 

88 
90 
91 
93 
94 
95 

"85 
91 
91 
93 
94 
96 96 

90 
92 
93 

92 
94 

96 96 
98 98 

97 
98 

99 98 

91 
91 
94 95 

94 94 95 
95 96 96 

97 
97 95 

96 97 
96 97 

93 95 97 102 108 112 113 109 99 89 
95 97 99 106 111 117 116 111 101 91 
96 98 101 108 115 120 118 112 102 92 
98 100 103 110 116 122 119 113 103 93 
99 101 105 112 116 123 121 114 104 94 
99 102 107 115 118 121 122 115 105 95 
98 103 108 117 122 119 122 115 105 95 
98 104 109 116 124 122 120 114 104 94 

97 99 104 110 118 121 123 118 113 103 93 

98 
97 
97 

105 105 101 99 96 98 97 101 105 110 117 122 121 118 111 101 91 
108 108 104 102 99 99 98 102 105 110 117 121 120 116 109 99 89 
108 108 105 105 102 100 100 101 104 109 114 119 117 113 107 97 87 
105 105 103 104 102 100 101 100 102 106 113 116 115 111 104 94 84 
104 104 101 102 100 100 100 99 103 105 111 114 112 109 102 92 82 
102 102 100 101 100 102 101 102 105 106 109 114 111 110 102 92 82 
100 100 98 100 101 103 102 104 107 108 110 114 111 110 103 93 83 
97 97 97 99 100 102 102 103 107 108 111 114 111 108 103 93 83 
96 96 96 98 98 99 100 102 104 106 110 112 110 106 101 91 81 
95 95 95 97 98 100 100 101 104 106 109 112 110 106 99 89 79 
93 
91 
89 
86 
82 

93 
91 
89 
86 
82 

96 
95 
93 
91 
88 
84 
80 

97 
94 
93 
90 
87 
83 

95 97 98 99 102 104 107 110 107 104 97 87 77 
94 96 96 98 101 102 106 109 106 103 96 86 76 
92 94 95 96 99 101 104 109 106 101 94 84 74 
89 91 91 93 96 98 102 107 104 99 91 81 71 
85 87 88 90 94 97 102 107 104 99 89 79 69 

Figure 3.0-3 Source SPL input file 

A sample log file generated in mode II (using "true" as the second command line input) can 
be found in Figure 3.0-4. The data in the sample file is from two time steps only. The log file 
contains similar data for each time step. The "Overall A-weighted SPL" value at the end of the data 
for each time step is the AL output to the SPL map file. Each line of data starting with "Src" 
represents one of the 24 frequencies. The data contained in this file is: 

Geom: 
LOS: 
SZ: 
Src: 
Grnd: 
Acfi 
Atm 
RawSPL: 
SPL: 

A-Weight SPL: 
Overall A-weighted SPL: 

dB loss due to spherical spreading 
dB loss due to terrain masking 
dB loss due to shadow zones 
Source input SPL (dB) 
dB gain due to ground impedance 
atmospheric absorption coefficient 
dB loss due to atmospheric absorption 
combination of Src, Geom, LOS, SZ, Grnd, and Atm 
RawSPL that has been smoothed to approximate exponentially 
weighted time averaging 
SPL after applying the relative frequency response for A-weighting 
A-weighted Sound Level 
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««« Start of Run »»» >» Plane: F16352 added  at 50696.000 
>» Plane: F16352 changed SPL at 50696.000 to 2 
... SPL: SoundDist=14827.2 Retarded Time=50653.4 AspectAngle= 177.41 
Frequency Independent Geom= -45.8 LOS= 0.0 SZ=-10.0 
Src= 91.6 Grnd= 0.6 Acf= 0.1 Atm=-4.9 RawSPL= 31.5 SPL= 31.5 AWeightSPL=   1.3 
Src= 93.6 Gmd= 0.6 Acf= 0.1 Atm=-6.1 RawSPL= 32.2 SPL= 32.2 AWeightSPL=   6.0 
Src= 94.6 Grnd= 0.5 Acf= 0.2 Atm=-7.8 RawSPL= 31.5 SPL= 31.5 AWeightSPL=  9.0 
Src= 95.6 Grnd= 0.5 Acf= 0.2 Atm=-9.7 RawSPL= 30.6 SPL= 30.6 AWeightSPL= 11.5 
Src= 96.6 Grnd= 0.5 Acf= 0.3 Atm=-12.2 RawSPL= 29.1 SPL= 29.1 AWeightSPL= 13.0 
Src= 97.6 Grnd= 0.6 Acf= 0.3 Atm=-15.6 RawSPL= 26.7 SPL= 26.7 AWeightSPL= 13.3 
Src= 97.6 Gmd= 0.6 Acf= 0.4 Atm=-19.5 RawSPL= 22.8 SPL= 22.8 AWeightSPL= 11.9 
Src= 96.6 Gmd= 0.6 Acf= 0.5 Atm=-24.4 RawSPL= 17.0 SPL= 17.0 AWeightSPL=   8.4 
Src= 95.6 Grnd= 0.7 Acf= 0.6 Atm=-31.6 RawSPL=  8.8 SPL=  8.8 AWeightSPL=  2.2 
Src= 93.6 Grnd= 0.7 Acf= 0.9 Atm=-42.6 RawSPL= -4.1 SPL= -4.1 AWeightSPL= -8.9 
Src= 91.6 Grnd= 0.8 Acf= 12 Atm=-56.4 RawSPL= -19.8 SPL= -19.8 AWeightSPL= -23.0 
Src= 89.6 Grnd= 0.9 Acf= 1.6 Atm=-78.5 RawSPL= -43.8 SPL= -43.8 AWeightSPL= -45.7 
Src= 86.6 Grnd= 1.0 Acf= 2.3 Atm=-112.5 RawSPL=-80.7 SPL=-80.7 AWeightSPL=-81.5 
Src= 84.6 Grnd= 1.1 Acf= 32 Atm=-157.9 RawSPL=-128.1 SPL=-128.1 AWeightSPL=-128.1 
Src= 84.6 Grnd= 12 Acf= 4.6 Atm=-2252 RawSPL=-195.3 SPL=-195.3 AWeightSPL=-194.7 
Src= 85.6 Gmd= 1.2 Acf= 6.8 Atm=-331.6 RawSPL=-300.7 SPL=-300.7 AWeightSPL=-299.7 
Src= 85.6 Gmd= 1.1 Acf= 9.6 Atm=-467.9 RawSPL=-437.0 SPL=-437.0 AWeightSPL=-435.8 
Src= 83.6 Grnd= 1.0 Acf= 13.6 Atm=-661.5 RawSPL=-632.7 SPL=-632.7 AWeightSPL=-631.4 
Src= 81.6 Grnd= 0.9 Acf= 19.3 Atm=-938.8 RawSPL=-912.2 SPL=-912.2 AWeightSPL=-911.0 
Src= 79.6 Grnd= 1.0 Acf=27.5 Atm=-1339.6 RawSPL=-1314.9 SPL=-1314.9 AWeightSPL=-1313 9 
Src= 78.6 Grnd= 1.1 Acf= 382 Atm=-1859.9 RawSPL=-1836.1 SPL=-1836.1 AWeightSPL=-1835 6 
Src= 76.6 Grnd= 0.9 Acf= 532 Atm=-2587.5 RawSPL=-2565.8 SPL=-2565.8 AWeightSPL=-2565 9 
Src= 73.6 Grnd= 1.1 Acf= 74.9 Atm=-3641.6 RawSPL=-3622.7 SPL=-3622.7 AWeightSPL=-3623.8 
Overall A-weighted SPL= 19.7 
50696.0    1 F16352: -11627.88   404.68   399.12 
...SPL: SoundDist= 14770.9 RetardedTime=50654.1 AspectAngle=177.42 
Frequency Independent: Geom=-45.8 LOS= 0.0 S^-10.0 
Src= 91.6 Grnd= 0.6 Acf= 0.1 Atm= -4.9 RawSPL= 31.5 SPL= 31.5 AWeightSPL=   1 3 
Src= 93.6 Gmd= 0.6 Acf= 0.1 Atm=-6.1 RawSPL= 32.2 SPL= 322 AWeightSPL=   6.0 
Src= 94.6 Gmd= 0.5 Acf= 0.2 Atm=-7.8 RawSPL= 31.6 SPL= 31.6 AWeightSPL=   9.1 
Src= 95.6 Gmd= 0.5 Acf= 0.2 Atm=-9.7 RawSPL= 30.6 SPL= 30.6 AWeightSPL= 115 
Src= 96.6 Grnd= 0.5 Acf= 0.3 Atm=-12.1 RawSPL= 29.2 SPL= 29.2 AWeightSPL= 13.1 
Src= 97.6 Grnd= 0.6 Acf= 0.3 Atm=-15.6 RawSPL= 26.8 SPL= 26.8 AWeightSPL= 13 4 
Src= 97.6 Grnd= 0.6 Acf= 0.4 Atm=-19.5 RawSPL= 22.9 SPL= 22.9 AWeightSPL= 120 
Src= 96.6 Grnd= 0.6 Acf= 0.5 Atm=-24.3 RawSPL= 17.1 SPL= 17.1 AWeightSPL=   8 5 
Src= 95.6 Gmd= 0.7 Acf= 0.6 Atm=-3U RawSPL=   9.0 SPL=  9.0 AWeightSPL=   24 
Src= 93.6 Gmd= 0.7 Acf= 0.9 Atm=-42.4 RawSPL= -3.9 SPL= -3.9 AWeightSPL= -87 
Src= 91.6 Gmd= 0.8 Acf= 12 Atm=-56.2 RawSPL=-19.6 SPL=-19.6 AWeightSPL=-22 8 
Src= 89.6 Grnd= 0.9 Acf= 1.6 Atm=-782 RawSPL= ^3.5 SPL=-43.5 AWeightSPL=-45 4 
Src= 86.6 Grnd= 1.0 Acf= 2.3 Atm=-112.1 RawSPL=-80.3 SPL=-80.3 AWeightSPL=-811 
Src= 84.6 Grnd= 1.1 Acf= 32 Atm=-157.3 RawSPL=-127.4 SPL=-127.4 AWeightSPL=-1274 
Src= 84.6 Gmd= 1.2 Acf= 4.6 Atm=-224.3 RawSPL=-194.4 SPL=-194.4 AWeightSPL=-193 8 
Src= 85.6 Grnd= 1.2 Acf= 6.8 Atm=-330.4 RawSPL=-299.4 SPL=-299.4 AWeightSPL=-298 4 
Src= 85.6 Grnd= 1.1 Acf= 9.6 Atm=-466.1 RawSPL=-435.2 SPL=-435.2 AWeightSPL=-434.0 
Src= 83.6 Grnd= 1.0 Acf= 13.6 Atm=-659.0 RawSPL=-630.2 SPL=-630.2 AWeightSPL=-628 9 
Src= 81.6 Gmd= 0.9 Acf= 19.3 Atm=-935.3 RawSPL=-908.6 SPL=-908.6 AWeightSPL=-907 4 
Src= 79.6 Gmd= 1.0 Acf= 27.5 Atm=-1334.5 RawSPL=-1309.8 SPL=-1309.8 AWeightSPL=-"l308 8 
Src= 78.6 Grnd= 1.1 Acf= 382 Atm=-1852.8 RawSPL=-1829.0 SPL=-1829.0 AWeightSPL=-1828 5 
Src= 76.6 Grnd= 0.9 Acf=53.2 Atm=-2577.6 RawSPL=-2555.9 SPL=-2555.9 AWeightSPL=-2556 0 
Src= 73.6 Grnd= 1.1 Acf=74.9 Atm=-3627.7 RawSPL=-3608.9 SPL=-3608.9 AWeightSPL=-3610 0 
Src= 71.6 Gmd= 1.0 Acf=102.3 Atm=^958.0 RawSPL=-494U SPL=-4941.2 AWeightSPL=-4943 7 
Overall A-weighted SPL= 19.8 
50696.5    1 F16352: -11587.77   384.62   396.01 «««End of Run »»» 

Figure 3.0-4 Output log file 
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When comparing SENM output against real world microphone data, the SPL values for each 
frequency for a specific time are used. The time used most often is the time the peak AL occurs. 
An example showing how real world measurement data can be compared to SENM output can be 
seen in Figure 3.0-5 The example compares the SPL values in the log file for each frequency at the 
peak AL time with microphone output, also from the peak AL time. 

The output file Prefix.jtlpos shown in Figure 3.0-6 stores the aircraft's positions at each 
simulation time step. One useful function of this file is to find the position of the aircraft at the time 
of the peak AL. The two other output files, Prefix .map and Prefix.avg are binary files and are not 
shown as examples. They are described in section 2.4. 

m 
■o 

Q. 
CO 

SPL Comparison 

17     23     29     35     41 

Frequency Band # 

Figure 3.0-5    Sample Analysis 

5Ö696.0 1 -11628 405 399 
50696.5 1 -11588 385 396 
50697.0 1 -11548 365 393 
50697.5 1 -11508 345 391 
50698.0 1 -11467 325 389 
50698.5 1 -11427 306 387 

50845.0 1 4817 -271 309 
50845.5 1 4948 -270 309 
50846.0 1 5081 -269 310 
50846.5 1 5213 -267 313 
50847.0 1 5347 -266 319 
50847.5 1 5481 -264 327 

Figure 3.0-6 Output plpos file 



4.0      DESCRIPTION OF THE GRAPHICAL MODEL AND 
EXECUTION INSTRUCTIONS 

The graphical model is a tool for animation and visualization of the output from the 
computational model. As stated earlier, it is based on the Motif 1.2.3 tool kit and therefore runs 

under the Motif window manager for X. 

Execution of the graphical model follows the standard model of all event driven X- 
windows programs. Interaction with the model is through pointer or keyboard events that trigger 
some action in the program. As such the following information will describe the current mouse 

and keyboard operations for interacting with the graphical model. 

The execution of the graphical model begins by entering 'Xnoise" on the command line. 
At that point, a main program window will pop up. The Xnoise main program window consists 
of the standard Motif window manager frame with window menu button, title area, minimize 
button, and maximize button. Additionally, within the window frame, are the menu bar, empty 
display area, and simulation 'Time" display area-initialized to 0.0 and grayed-out. These items 

are shown below in Figure 4.0-1. 
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Figure 4.0-1 Main Window 
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As a Motif compliant application, Xnoise follows the conventions of the Motif window 

manager for interacting with the application at the top-level. Therefore, using the pointer on 

various parts of the frame you can: 

• Display the Window Menu by clicking the first pointer button on the Window Menu 

command button, the button located in the upper-left corner of the frame (decorated with 

a rectangle). This menu provides seven items that can be used to manage the window and 

its icon and provide the same results as if other parts of the window frame (described 

below) were accessed. The application can be closed or killed by double-clicking on the 

Window Menu command button. 

• Iconify the window by clicking the first pointer button on the Minimize command button, 

the left-hand button in the upper-right corner of the frame (decorated with a small 

square). To convert the icon back to a window, double click on the icon with the first 

pointer button. 

• Maximize the window to its full size by clicking the first pointer button on the Maximize 

command button. This button is to the right of the Minimize button and is decorated with 

a larger square. To convert the window back to its original size, click on the Maximize 

button again. 

• Raise a window to the foreground by clicking the first pointer button on any part of the 

window frame except the three command buttons (Window Menu, Minimize Maximize). 

• Move the window by pressing and holding down the first pointer button on any part of the 

title area (except the command buttons), dragging the window outline to a new location, 

and releasing the pointer button. To move an icon, place the pointer on the icon, press 

and hold down the first pointer button, drag the icon outline to the new location, and 

release the pointer button. 

• Resize the window by moving the pointer into one of the resize borders or corners, 

pressing and holding the first pointer button, and dragging the border or corner in the 

direction you want. A window outline tracks the resize operation. Release the pointer 

button to redraw the window in the new size 
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An example of the Window menu and the locations of command buttons are shown below 

in Figure 4.0-2. 

Window Menu 
Command Button 

Minimize 
Button 

Maximize 
Button 
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Is 

Tame 

Figure 4.0-2 Window Attributes 

Additionally, the Xnoise application uses "tear-off menus which you can post in sub- 
windows that remain on display until removed. Posting the sub-window is accomplished by 
clicking the first pointer button on the "perforated" or dotted line in the menu. The tear-off menu 
behaves just like a main window except it cannot be minimized or maximized. All other Motif 
window attributes behave as described above. The tear-off menu also has a Window menu 
accessed by the same Window menu button in the upper-left hand corner. All main window 
menus in the Xnoise application use tear-offs, therefore making it easy to access frequent menu 

items. An example of a tear-off menu is shown below in Figure 4.0-3. 

21 



Figure 4.0-3 Tear-off Menu with Window Menu on 

As stated above, the main program window includes a menu bar. This menu bar consists 

of five buttons: File, Edit, View, Options, Help. These buttons on the menu bar provide lower 
level menus for interacting with the application. These lower level menus are accessed by 
clicking the first pointer button on the text of the menu you wish to access. Currently, only the 
File, View, and Options submenus have menu items that interact with the application. The Edit 
and Help submenus have place holders for future items that will be added. 

The File menu is shown in Figure 4.0-4 and is capable of being posted as a tear-off menu. 
It consists of two menu button items: Open and Exit. 

Figure 4J0-4 File menu 
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The Open menu button is the primary means of accessing the display capabilities of the 

application. If you do not open a file, any attempt to access other main menu items will result in 
the posting of an Information Dialog Box (IDB) indicating that you must first open a file (Figure 

4.0-5). You dismiss this dialog box by clicking the first pointer button on OK. 
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Figure 4.0-5 Information Dialog Box 

When the Open menu button is selected, a File Selection Dialog Box (FSDB) is posted in 

the center of the Xnoise display window (Figure 4.0-6). 
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Figure 4.0-6 File Selection Dialog Box 

23 



The FSDB provides an interactive means to select files. As a default, the file selection 

filter is set to list all files with the parameter file extension "parm". The parameter files listed in 

the Files window of the FSDB are the same as the parameter files from the computational runs. 

A parameter file can be selected and opened by either double-clicking with the first pointer 

button on the desired file or by highlighting with a single click of the first pointer button the 

desired file and then a single click on the Open button in the FSDB. If the desired file is not 

displayed in the Files window, you can traverse the directory tree by double-clicking on the /.. 

entry in the Directories window. In the event that a selected file cannot be found or read, an 

Error Dialog Box (EDB) is posted indicating the nature of the error (Figure 4.0-7). 

Figure 4.0-7 Error Dialog Box 

Once a file is properly selected and opened, Xnoise performs a number of actions that 

will result in the display of a Aweighted Sound Pressure Level (AL) map. As you might recall 

the AL map file contains the AL value for each grid point per each time step throughout the 

computational simulation. 

The first action is that the application changes the pointer cursor to a watch cursor to 

indicate a lengthy action is taking place. Additionally, all keyboard and pointer events are 

disabled to prevent the user from taking any actions during the display of the first map image. 

Next, the parameters file from the computational run is opened, read, and stored for later access 

by Xnoise. Memory is then dynamically allocated for the storage and manipulation of the AL 

map file and the values from the file are read and stored. As additional visual feedback to the 

user, an IDB (Figure 4.0-8) is posted indicating the AL map file is being read. 
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Figure 4.0-8 Reading the AL Map File 

Once the AL values are read, they are then converted to color levels for display. The color 
levels indicate the intensity of the AL in dB A. Values displayed range from 25 to 125 dB A and 
each value is represented by a unique color. The color spectrum starts at blue for the lowest AL 
value, goes through green and yellow, and finally ends at red for the highest AL value. As 
additional visual feedback to the user, an IDB (Figure 4.0-9) is posted indicating the AL map file 

is being converted. 
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Figure 4.0-9 Converting ALs to Color Levels 

When the AL values are converted to color levels, Xnoise sets the Time window to the 
beginning of the simulation time, scales the information to fill the display, and puts the first AL 
map image into the display window (Figure 4.0-10). At this point, the cursor is changed back to 
its original shape and event control is returned to the user. 

Figure 4.0-10 First AL Map Image 
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Once the first AL map image is displayed, the user can then access the menu items in the 
View and Options menus. The View menu is shown below in Figure 4.0-11 and is capable of 
being posted as a tear-off menu. The View menu provides a means to step through and animate 
the computational output, displaying each AL map in the simulation. The menu item buttons on 
the View menu include: First AL Map, Last AL Map, Step Forward, Step Backward, Run 

Forward, and Run Backard. 
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Figure 4.0-11 View Menu 

The First AL Map menu button will bring the first AL map image to the window display 
and set the Time display window to the beginning of the simulation time. It provides a quick 
means to return to the beginning of the AL map images from what ever image you are currently 
viewing. In the event that the current image in the display is the first AL map image, an IDB is 

posted (Figure 4.0-12). 



Figure 4.0-12 Information Dialog Box 

The Last AL Map menu button will bring the last AL map image to the window display 

and set the Time display window to the simulation time prior to the aircraft removal from the 

computational model. It provides a quick means of jumping to the end of the AL map images 

from what ever image you are currently viewing. In the event that the current image in the 
display is the last AL map image, an IDB similar to that posted for the first image is displayed. 
Figure 4.0-13 shows the result of pressing the Last AL Map menu item for the current parameter 
file. 

I 

Figure 4.0-13 Last AL Map Image 
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The Step Forward and Step Backard menu buttons provide a means to interactively 
move forward and backward within the simulation from your current location in the AL map file. 
Each displays either the next or previous AL map image and the simulation time associated with 
the map image. The step size for forward or back is initially set to the simulation step time in the 
parameters file. However, the step size can be changed from the Options menu that will be 
discussed below. The final menu items are Run Forward and Run Backward and it provides 
an animation capability by stepping through each of the AL map images in a rapid fashion. As 
with the Step Forward and Step Backward menu items, the time step of the animation can be 

controlled from the Options menu. 

The Options menu controls a number of items associated with viewing the AL map 
images. These items include the minimum AL level displayed, time-step playback size, contour 
plotting of terrain, and proportionality of the image in the display window. All these options can 

be accesses through the Options menu (Figure 4.0-14). 
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Figure 4.0-14 Options Menu 
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The first menu item under the Options menu is the Floor menu button. When the Floor 

menu item is selected, a dialog box is popped up that contains a scale slider for setting the 

minimum displayed AL value. The slider bar has a minimum value of 25 dB A and a maximum 

value of 125 dB A (Figure 4.0-15) and is mapped to the color levels in the display window. 

Figure 4.0-15 Sound Floor Range 

The user sets the minimum AL value to be displayed by holding the first pointer button 

down over the slider bar and dragging it to the right or left to increase or decrease the value and 

then releasing the first pointer button. The screen will clear and then the display window will be 

redrawn at the minimum AL value. The AL floor remains in effect until changed or a new file is 

opened. By default, the AL floor is set to zero to display the entire AL map. Constant visual 

feedback of the minimum displayed AL value is provided by a numeric indicator above the slider 

bar. 

An alternative means to move the minimum value one unit at a time is to simply click the 

first mouse pointer button on the slider scale. To increase the AL floor one unit at a time, click 

the first pointer button on the slider scale to the right of the slider bar. To decrease the AL floor 

one unit at a time, do the opposite of the above. Figure 4.0-16 shows an example of the last 

image from the opened AL map file with the sound floor set to 75 dBA. 
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As mentioned above, the time-step for displaying the AL map images can be modified. 

This is accomplished through the Speed menu item. When the Speed menu button is selected, a 
dialog box is popped up and contains five toggle buttons representing multiples on the 
computational time-step. For example, the computational time-step is 0.5 seconds. To display 
AL map images of two second intervals, the 4x toggle would be selected. The time-step multiple 
remains in effect until changed by the user. The default multiple is one time the computational 

simulation time-step. Figure 4.0-17 shows an example of the Speed dialog box. 

m "*     - *   ff -'"-.'   <■     ' Amsk 

: ? , K    ;\k.        m% 

I 1 

si 

Figure 4.0-17 Speed Dialog 

The last menu item under the Options menu is Toggles. Selection of this menu button 
will pop up a dialog box containing four toggle buttons for turning on and off overlays on the AL 
maps in the display window. Currently the Aircraft button is not active but is planned for the 
next release. However, the MicroPhones, Terrain, and Proportional buttons are active (Figure 

4.0-18.). 
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Figure 4.0-18 Toggles Dialog 

The Terrain toggle button turns on and off an overlay of terrain contours on the AL map 
image. When the button is toggled on, the display window is cleared an the terrain contours are 
calculated from the terrain database file listed in the parameters file. The previsous version of the 
program did not allow for stroage of the calculated contour vectors. This sitiuation has been 
rectified and as a result, it is now possible to display the terrain contours overlay in conjunction 
with the playback animation of the AL maps. In fact, all overlays can be used in conjuction with 
the animation of the AL maps without any loss in program performance. Figure 4.0-19 shows an 
example of a terrain file overlaid on a AL map 
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Figure 4.0-19 AL Map Image with Terrain Contour Overlay 

By default, AL map images are scaled to fill the entire display. This is the case even if 
the area of interest is smaller than the display window. For example, if the area of interest 
represented a grid of 400 horizontal grid points by 100 vertical grid points, Xnoise would scale 
the AL map image to make 100 vertical grid points fill the vertical portion of the display 
window. Consequently, a AL map image may appear distorted in either the horizontal or vertical 

direction from what one would expect. To change the default and force the AL map image to be 
displayed proportionally in relation to the grid size, the Proportional toggle button is selected. 
When selected, the display window is cleared and the image is resized so that either the 
horizontal or vertical direction will fill the display window and the other direction will be sized 
to maintain the same proportion as the original input grid. Figure 4.0-20 shows an example of 
the Proportional toggle button in operation on the current open file.  The original image has 
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been rescaled to eliminate the previous vertical distortion and give a true rendering of the shape 
of the acoustic field. 

Figure 4.0-20 AL Map Image in Proportional Mode 
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The Microphones toggle button is the newest feature to the program. It allows the user 
to interactively turn on and off the display of an overlay of microphone locations from the input 
parameters file. When the button is toggled on, the display window is updated with whatever 
lable was assigned to the microphones in the input parameter file. Figure 4.0-21 shows an 
example of a set of eight microphones ovelayed on the AL map along with the terrain contours. 
The microphones are labled with the numbers one through eight as assigned in the input 

parameter file. 
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Figure 4.0-21 AL Map Image with Microphones and Terrain Contour Overlays 

35 


